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1 Welcome 
 
Welcome to the V5.3 version of GEMLink for Windows.  
It supports all Windows (8/7/Vista/XP/2000/98/95). It supports more USB-RS232 
adaptors with reliable and rugged connection among Mag/Grad with PCs.  
This version of GEMLink is intended to provide a reliable and robust system for rugged 
applications. Also it gives an upgraded interface to the Windows Operating system and to 
streamline data transfer to and from the magnetometer. If you experience any difficulties 
or have suggestions, we would appreciate hearing your comments. Please send an email 
to info@gemsys.ca and include "GEMLink V5.3" in the header line of your email. 
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2 INSTALLATION  
1. If you are a previous GEMLink user, we strongly advise you to install latest 

version from our website. so that you can take advantage of the new features and 
fixes in this version. 
http://www.gemsys.ca/technology/software/ 

2. When installing a newer version of GEMLink, uninstall the older version first. 
This is a general rule that should be followed when installing any software to 
ensure that Windows functions properly. 

3. To uninstall the previous version, click 'START' from the Windows task bar. 
Select 'Settings' and click 'Control Panel'. Double-click on 'Add/Remove 
Programs'. Locate and click on GEMLink and click the 'Add/Remove' button.  

4. To install GEMLink, first run setup.exe and follow the instructions. You may 
need administrator privilege to do it. 
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3 PERFORMANCE NOTES 
1. Slower, older computers may not be able to perform if the baud rate is set too 

high. If the capacity of the data buffer is exceeded, the 'Received' panel of the 
status bar will indicate "OVERFLOW", and "BUFFER OVERFLOW" will be 
inserted between the data lines. 
 
If new data arrives to the port before the UART's FIFO is emptied (operating 
system failure), the status bar will indicate "OVER RUN" and "PORT OVER 
RUN" will be inserted between the data lines. 
 
To avoid this problem, reduce the baud rate and compare the number of bytes 
received from the same file over several runs to establish a safe rate of operation. 

2. The overall performance of older computers not only depends on the speed of the 
processor. It is greatly affected by the characteristics of the port itself and also the 
video card. 
 
You may be able to achieve higher transmission rates by setting the text window 
to 'Not Active'. This alleviates the processor and Windows of having to update the 
screen and frees resources for data transferring. 
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4 Function Description 
 

4.1 GEMLink main user interface and functions 
 
 
 
 
 
 
  
 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
GEMLink main user interface contains menu bar, Serial Port Configure panel, text 
window to show serial port content and status bar which can be used to set configuration 
and status indication. There is detail information description for those functions in below. 

 

Menu Serial port configuration 

Serial port content showing area 
 

Received 
Bytes 
counter 

Received 
buffer 
indicator 

Text edit  
switch 

Content 
display 
switch 

Capture 
indicator 

Word 
wrap 
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Status 
bar 
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4.1.1 Serial Port Configuration 

 
1. Port 
When the application starts, the program searches for available serial ports on the PC, 
the port and port settings are the ones used in the last session by default. 
 
If the default port is unavailable (i.e. because another application is using it), the 
system selects the first one available. 
If there are no ports available at all on the PC, GEMLink will display a message. To 
correct this, you must free the ports that are in use by closing other applications. Then 
click the drop-down arrow of 'Port' or click 'Find ports' command under the 'Options' 
menu in GEMLink or use the F12 shortcut. Select a port from the updated entries in 
the Ports dropdown list. 
 
If you want to use another port or to change the current port, you can do so by using 
the Port dropdown list, or by pressing the F7 key to scroll through the available port 
one by one.  
If user is using USB serial port adapter, in case of there is no COM port shown in 
GEMLink’s port list, or not sure about the port of the USB serial port adapter, please 
check as following step: 
1) Please click startup icon-> right click "computer"->click popup menu "properties" 

--> click "Device Manager" in shown window "Control panel .... system". 
2) Please check item "Ports" in the hardware list, there should like  "Prolific USB-to-

Serial Comm Port(COM3)" which will display your RS-232 converter brand and 
set it into COM port in GEMLink. 

3) If there is no such hardware showing in your "Device Manager", and there is a 
question mark for some unknown-device, please install the driver GEM system 
Inc. provided, unplug/plug the converter again. 
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2. Rate 
Use the Rate dropdown list in GEMLink to select the receiving baud rate. You can 
also increment the rate one step at a time using the F8 key. Note that this rate must 
match the transmission rate of the data source. Usually using 115200 is for most 
MAG of GEM system Inc. 
3. Setting 
Set other port settings (such as parity and stop bits) by clicking on the 'Settings' text 
box in GEMLink. Use commas to separate the characters you enter. Illegal entries 
will be rejected. Usually using ‘n,8,1’ is for most MAG of GEM system Inc. 
4. Flow Control 
Flow Control supports mode None, Xon/Xoff and Hardware. 
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4.1.2 Status bar 

 1. Rcvd 
Serial port received data length in byte. The progress bar on the right indicates buffer 
status of the text window. Clicking the progress bar, user can set a new buffer number 
for the test window.  It recommends that the window buffer is limited below 80MB, 
otherwise the performance will be impacted if text window stores too much content 
or lead to out of memory crash for program. 
  
2. Data edit 
Locked: text window can not be edited online. 
Not Locked: text window can be edited online. 
 
3. Text window 
Active: Data received from serial will show on the text window. 
Not Active: Data received from serial will not show on the text window. 
 
4. Capture mode 
OFF: There is not in capture mode. 
Binay: Program is in binary capture mode. 
Text:  Program is in Text capture mode. 
 
5. Word Wrap 
ON : Text window is word wrap enabled. Long line data will be interrupted into 
following line. 
OFF: Text window is word wrap disabled. One line content show in the same line, 
user have to move scroll bar right to see the over-length data. 
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4.1.3 Serial Port Data Collection operation steps 

1. Once a serial port is open, the application is ready for action. Any data received 
by the port will be transferred to the text window, provided it is set to 'Active'. To 
see the current status, select the 'Options' menu > 'Text window' submenu in 
GEMLink. 

2. You can change the text window status by: 
 using the 'Options' menu > 'Text window' submenu 
 the F3 shortcut 
 clicking on the 'Text window' panel of the status bar.  
 

3. GEMLink treats data in the text window the same as any text typed in a text 
editor. You can save it, print it, and (depending on the status of the 'Data edit' 
command) edit it. To see the current status, select the the 'Options' menu > 'Data 
edit' submenu. 

4. By default, the default edit condition is 'Locked' so that data integrity is protected. 
If you change the 'Data edit' condition to 'Not Locked', you will find that all the 
normal keyboard editing shortcuts are supported. You can also access standard 
Windows editing commands by right-clicking on the text window.  

5. You can change the data edit status by: 
 the 'Options' menu > 'Data edit' submenu 
 the F2 shortcut 
 Clicking on the 'Data edit' panel of the status bar.  
 

6. All keystrokes on the text window are transmitted to the serial port as ASCII 
characters. This is necessary on units, such as the GSM-90, that are controlled 
through the RS232 line, and also for external RS232 trigger. For your reference, 
each transimtted character and its decimal and hexadecimal values are displayed 
above the text window and under the menu bar. 
 
If you use this feature when editing is Not Locked, you may see double characters 
on the text window. One is the one you typed, and the second is the one echoed 
by the unit via the RS232 line (not all units echo the commands).  

7. The 'Capture' command under the 'File' menu allows you to write to a file as the 
data is being received. Text and Binary modes are supported.  
 
If the incoming data is composed of ASCII characters, both modes function the 
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same way. If the data is in hexadecimal format, you must select the binary mode.  
 
To select a mode, either access the 'File' > 'Capture' command or use the 
appropriate shortcut (F4 for text and F5 for binary). 

8. When finished receiving data, you can close the captured file by: 
 using the 'File' > 'Capture' > 'Stop capturing' command  
 the F4 shortcut 
 clicking on the 'Capture mode' panel in the status bar  

 
When capturing in binary mode, the text window is disabled since it is only 
capable of displaying text. Once the captured file is closed, the status of the text 
window will depend on the current text window setting. 

9. The 'Rcvd' panel in the status bar displays the number of characters or bytes 
received. The counter will reset when opening or saving a file, or when opening a 
capture file.  
 
When closing a capture file, the counter is reset but the number remains on 
display. You can also reset the counter manually at any time by clicking on the 
'Received' panel of the status bar. 
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4.1.4 File Menu functions 

 

  
1. Open(Ctrl + O) 
This function will prompt an open file dialog which user can select the MAG log file user 
want to load it. 
The files must be ASCII text files. The end of each line of text must have a CR (carriage 
return) or CRLF (carriage return/Line feed). Lines terminated only with LF cannot be 
used since they are treated as a single one.  
 
2. Save(Ctrl + S) 
This function is to save current content to a file. If the file is already loaded (file name is 
in the caption of the application window), the text window content will be written into it. 
Otherwise, application will pop up a save file dialog and ask user choose a new file name.  
 
3. Print 
Print function contains 2 sub functions: Print setup, Print preview and Print 
Print setup: a Page Setup window will pop up to let user change the print page format. 
Print preview: a print preview window will pop up to show preview of the text window 
content. 
Print: This function will send text window content to the printer which user selected.  
 
4. New (Ctrl + N) 
This function will clear text window content and create a untitled document for the serial 
port data receiving. 
 
5. Capture 
Capture function has two mode: Text and Binary. 
 
Text(F4): Serial port data will be received and written into a *.txt file. After clicking this 
menu, application will ask user to assign a text file name to store the log. After finishing 
logging, clicking ‘Capture’ ’Stop capturing’ will end the log writing process. 
Information will be shown to user to indicate that how much byte content has been 
written into the log file. 
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Binary(F5): Serial port data will be received and written into a *.bin file. After clicking 
this menu, application will ask user to assign a binary file name to store the log. After 
finishing logging, clicking ‘Capture’ ’Stop capturing’ will end the log writing process. 
Information will be shown to user to indicate that how much byte content has been 
written into the log file. 
 
 
6. ZIP Tools 
 
Usually, MAG log file in text format will use much more storage space than the zip 
format file. GEMLink proivse ‘ZIP file(s)’ and ‘UnZip’ function for user to compress and 
decompress the log file. 
 
‘ZIP file(s)’: Click Menu ‘ZIP file(s)’Select or create a zip fileSelect source 
fileGEMLink generate zip file. 
 
‘UnZip’: Click Menu ‘UnZip’Select source zip fileSelect unzip file GEMLink 
generate unziped file. 
 
Options: it will prompt an option window for zip/unzip progress with. Click the tab page 
you can set options by clicking checkbox. 
 

  
 
7. Exit 
Exit GEMLink application. 
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4.1.5 Options Menu functions 

 Options menu is for serial data receiving and text window showing. 
1. Find ports(F12) 
'Find ports' command under the 'Options' menu in GEMLinkW or use the F12 
shortcut. It’s for selecting a port from the updated entries in the Ports dropdown 
list.  
2. Text window 
Text window contains 3 sub functions: 
Active: Checked status: Data received from serial will show on the text window. 
Not checked status: Data received from serial will not show on the text window. 
 
Receiving Buffer: By clicking this menu button, user can set a new buffer number for the test window.  It 
recommends that the window buffer is limited below 80MB, otherwise the performance 
will be impacted if text window stores too much content or lead to out of memory crash 
for program. 
 
Word wrap: Checked status: Text window is word wrap enabled. Long line data will be interrupted 
into following line. 
Not checked status: Text window is word wrap disabled. One line content show in the 
same line, user have to move scroll bar right to see the over-length data. 
 
3. Data edit 
Checked status: text window can not be edited online. 
Not checked status: text window can be edited online. 
 
 
4. Find text(Ctrl + F) 
Find function is to search whole text window content for the text string filled by user in 
the find option window as following.  
Note: In data edit lock mode the replace is not available. 
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5. Hex Mode 
Checked status: text window shows string text in Hex mode. 
Not checked status: text window show string text in character/text mode. 

 

北
京
欧
华
联
科
技
有
限
责
任
公
司



 1

 
4.1.6 Tools Menu functions 

 
1) Diurnal correction 

This utility is designed to perform corrections of Magnetic Diurnal Variations to data 
files on the PC instead of using the diurnal correction feature of the magnetometers.  
 
Now, you can correct Base and Rover files that have already been dumped (even erased 
from the magnetometer's memory). This utility also eliminates the need to interconnect 
the two instruments. 
 
Two files are needed to run the utility. One from the Rover (or mobile) magnetometer 
and the other from the Base Station magnetometer. 
 
The result will be a third file which contains all the information of the Rover file, plus the 
corrected magnetic field appended at the end of the line. 
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FILE NOTES: 

The files must be ASCII text files. The end of each line of text must have a CR 
(carriage return) or CRLF (carriage return/Line feed). Lines terminated only with 
LF cannot be used since they are treated as a single one.  
The default delimiter between fields or columns is SPACE. A different delimiter 
can be selected from the 'Field Delimiter' menu under the 'File menu'. . The 
selection will be save as a permanent setting, it means it is still effective next time 
you use GEMLink. 
 
Note that both Base and Rover files must have the same delimiter. If you choose 
an incorrect delimiter, the system may product unexpected results or errors. 
Here is an example of format of Data: 
 

/X Y elevation nT sq cor-nT sat time picket-x picket-y slope n*[kHz ip op h1 h2 pT] 
line  000001 
 054.7169061 -007.1277348  000303  49544.35 99  000000.00 09 S 145205.0 06055N  0000057 N   0000N  
16.0 +027.5 +051.0  034  067 000.90 19.6 -064.3 +011.7  042  072 013.04 24.0 -058.6 +000.7  006  061 
003.94  

 

  
 
TIME STAMP NOTES: 

Since the release of GEMLink 2.4, the diurnal correction utility offers increased 
flexibility regarding the format of the time stamps. Base AND Rover files accept 
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the following time stamps in 24hr (military format):  
 
HHMMSS; HHMMSS.s; HHMMSS.ss; HHMMSS.sss; HH:MM:SS; 
HH:MM:SS.s; HH:MM:SS.ss and HH:MM:SS.sss 
 
Entries not matching these formats are rejected. Furthermore, if 240000.0 is found 
as a time stamp representing midnight, it will be considered as 000000.0 . Minutes 
and seconds cannot exceed 59. Entries that match these formats but have an 
illegal value for Hours Minutes or Seconds are also rejected.  

 
TIME CONVERSION NOTES: 

To help facilitate comparison of time entries, all times are converted to tenths of 
seconds (1/10 sec) by a simple weighed addition of hours, minutes, seconds and 
fraction of seconds.  
 
Although times stamps with three decimal places are accepted, the times are only 
compared to the tenth of a second. The 2nd and 3rd decimal places are discarded 
with no rounding.  
 
Time stamps such that 0 =< |Base time - Rover time|<= 0.099 sec are considered 
to be equal.  

 
SYNCHRONIZATION NOTES: 

To perform Diurnal corrections the Base and Rover units must, of course, be 
synchronized to the same starting time before the survey. This facilitates accurate 
data reduction following the survey. 

 
If both units are equipped with GPS they automatically synchronize to UTC and their 
reading cycle is therefore controlled by the GPS timing.  
If only one unit is equipped with GPS, you may want to synchronize that unit to UTC and 
then use the synchronization cable to transfer the UTC time to the other.  
In this case, the cycling of one unit is synchronized to GPS time with every reading 
taken. The other unit runs on its internal timer with no further GPS synchronization. 
Therefore, there may be a time discrepancy between the two units. This is only an issue 
for long surveys or unattended base stations without GPS. 
If none of the units is equipped with GPS, set the time manually in one of them and use 
the synch cable to transfer the time to the other. 

  
DATE NOTES: 
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The date of the files is not checked. Make sure both files belong to the same day. 
The file times must not cross over midnight since no provisions have been taken to 
compare times in this case. 
Note: Since the release of GEMLink 5.3, the diurnal correction utility will check if the 
date of Rover file and Base file are the same date. If they are not in the same date, 
application will show warning. It strongly recommends that Rover file and Base file 
should be generated at the same date. 

 
INCLUSION OF CORRECTED LINES: 

If the 'Include non corrected lines' is checked (default) on the Diurnal Correction 
utility dialog box, the system stores the data lines that could not be corrected 
without any changes. The result is a file with all the readings of the Rover, 
however, only the corrected lines will show the corrected magnetic Field 
appended at the end of the line. 
 
If the option 'Discard non corrected lines' is checked, the result is a file containing 
only the lines that were successfully corrected. 

 
USAGE NOTES: 

After you open a file for the Base or for the Rover, the system displays the Setup 
window. The text box shows the first 50 lines of the file for your reference.  
 
The program then checks the selected file to determine the first and last lines of 
data. The first line is defined as the first of 3 consecutive lines with the same 
length. The last line is defined as the line closest to the end of the file that has the 
same length and number of field delimiters as the first.  
 
The first line of data is parsed based on the current field delimiter setting, and 
values are passed to the Time and Magnetic Field dropdowns. The values of the 
drop-down boxes are used to determine the position of each field within the line 
and its format.  
 
It is not possible to select other values than the ones presented as options (from 
the first line of data). If other values are encountered, you will see an error 
message. The conversion process will fail or yield unexpected results if the fields 
of the lines are not separated by the selected field delimiter. 
 
A datum can be entered at any time either on the Rover or the Base setup window. 
 
When you are ready to start the correction process (i.e. when both files are open), 
press the 'Correct' button in the Diurnal Correction utility dialog box. 
 
The program first checks the files to determine if they have readings in common. 
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If the time intervals from beginning to end of the two files do not overlap, then 
correction is not possible and the process stops.  
Once again, remember that the files are only compared according to their time and 
the date is not taken into account. Make sure both files belong to the same day. 
 
The time extracted from the first data line of the Rover's file is compared to the 
times of the Base file. 
 
If the time of the Rover is not one of the readings in common, (i.e. its time does 
not fall within the overlapping time intervals), the data line is either passed 
untouched or discarded depending on the setting of the 'Include' 'Discard' options. 
 
If it is a common reading, correction could be made in one of two ways. 

 
If the exact same time is found in the Base file, then the magnetic field correction is 
calculated as: 

Corrected Value = Rover Field - Base Field + Datum 
 

The corrected value is appended at the end of the Rover's data line and the line will be 
flagged with "i---" 
If the times do not match exactly, then the Field of the Base is linearly interpolated from 
the closest-in-time readings of the Base file. The corrected Field is then calculated as:  

Corrected Value = Rover Field - Interpolated Base Field + Datum  
 

As a measure of the quality of the results, the time interval (in seconds) of the Base lines 
used for the interpolation is also added at the end of the line. For example, a corrected 
field interpolated from base readings 5 seconds apart will be flagged with "i005".  
If the time interval excedes 999 seconds the line will be flagged with "i+++". 
The same process continues with the other lines of the Rover and until all lines are 
checked. 
 
Invalid data lines in the Rover file (such as position labels or comments, or lines that do 
not contain a valid time format or the field separator) are passed to the new file 
untouched. If the line contains a valid time but some of its values cannot be extracted, 
you will be warned with a message showing the invalid line and the line will pass to the 
final file flagged with "Error". 
 
Previous versions of GEMLink were less tolerant of invalid data lines in the Base file. 
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However, since GEMLnkW 2.4, you are now warned with a message displaying the 
invalid line and the process will continue with the next valid line. To avoid seeing these 
messages, we recommend that you do not edit the files (i.e. use them exactly as they are 
dumped from the magnetometers). 
 
At the end of the cycle, a summary message displays the number of readings that were: 
corrected directly 
corrected using interpolation 
not corrected.  
The number of time stamps that had correct formats but illegal numbers, such as Hours, 
Minutes or Seconds (if any), are also displayed.  
 
You can use this information to inspect and modify files. However, you must first 
determine in which file the illegal entries are located and their location within the file. If 
the bad time was from the Rover file, it will be in the final file flagged as '****'. The 
same summary is inserted at the end of the corrected file.  
 
During the cycle the corrected data is stored in a temporary file named dummy.dmy 
which is created automatically. This file is saved even in the event of a fatal error.  
To recover the data you have corrected so far, you should open the dummy file which is 
located in the folder in which GEMLink is installed. The dummy.dmy file is overwritten 
with no warning when a new correction cycle begins. 
SAVING THE DATA: 
When exiting the utility, you are asked to save the final file. This process simply renames 
the dummy file to the path and file name of your choice. In the event of an error when 
saving (for example, when the path or drive is not available), the program will display a 
message indicating that your merged data is still available in the dummy.dmy file and 
showing its location. Should you decide to cancel and exit without saving/renaming the 
file, the dummy file will remain intact. 
 
Note that some other GEMLink tools, such as the merging utility (GPSmerge), use the 
same dummy.dmy file. Always save or rename your file to avoid loosing the data. 
During GEMLink usage, Diurnal Correction 's base file can be stored at text edit box for 
multi-rover log correction.  But in order to avoid leading user to make mistake, after 
closing GEMLink, this base file information will be cleaned. 
 

 
2) Merging Utility 

This GEMLinkW tool is a merging utility to overwrite or append the positioning data 
obtained from the magnetometer’s memory with the post-processed DGPS coordinates 
obtained from GPS post-processing software. 
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Two files are needed to run the utility: 
Rover or mobile GPS/magnetometer file that contains the magnetic field readings with 
the time stamp and the raw or uncorrected GPS coordinates.  
One with the corrected DGPS coordinates. This second file is normally obtained from a 
third-party DGPS software (such as GrafNav from Waypoint Consulting Inc) by 
combining or post-processing the binary GPS data stored during survey in the Base 
Station and Rover GPS/magnetometer units. 
The utility creates a third file containing all the rover magnetic information and/or the 
post-processed DGPS coordinates. 
 
 
FILE NOTES: 
The files must be ASCII text files. The end of each line of text must have a CR (carriage 
return) or CRLF (carriage return/Line feed). Lines terminated only with LF cannot be 
used since they are treated as a single one.  
 
The default delimiter between fields or columns is SPACE. A different delimiter can be 
selected from the 'Field Delimiter' menu under the 'File menu'. The selection is not a 
permanent setting. SPACE is the default delimiter each time GEMLinkW opens.  
 
Note that both Base and Rover files must have the same delimiter. If you choose an 
incorrect delimiter, the system may product unexpected results or errors. 
 
TIME STAMP NOTES: 
Since the release of its version 2.4, GEMlinkW offers increased flexibility regarding the 
format of the time stamps. Base AND Rover files accept the following time stamps in 
24hr (military format):  
 
HHMMSS; HHMMSS.s; HHMMSS.ss; HHMMSS.sss; HH:MM:SS; HH:MM:SS.s; 
HH:MM:SS.ss and HH:MM:SS.sss 
 
Entries not matching these formats are rejected. Furthermore, if 240000.0 is found as a 
time stamp representing midnight, it will be considered as 000000.0 . Minutes and 
seconds cannot exceed 59. Entries that match these formats but have an illegal value for 
Hours Minutes or Seconds are also rejected.  
 
For this reason, when exporting the data from the DGPS post-processing application, care 
must be taken in selecting one of these formats.  
 
Note that both GPS and magnetometer times must be in the same units. Since the time of 
the magnetometer file is normally HHMMSS.s UTC, you cannot merge to a GPS file 

北
京
欧
华
联
科
技
有
限
责
任
公
司



 2

with the time in, for example, seconds of the week. The files must not cross over 
midnight since no provisions have been taken to compare the times in such case. 
 
TIME CONVERSION NOTES: 
To help facilitate comparison of time entries, all times are converted to tenths of seconds 
(1/10 sec) by a simple weighed addition of hours, minutes, seconds and fraction of 
seconds.  
 
Although times stamps with three decimal places are accepted, the times are only 
compared to the tenth of a second. The 2nd and 3rd decimal places are discarded with no 
rounding.  
 
Time stamps such that 0 =< |Base time - Rover time|<= 0.099 sec are considered to be 
equal.  
 
WAYPOINT'S GrafNav SOFTWARE NOTES: 
Waypoint's GrafNav DGPS post processing software includes a very versatile export 
wizard that allows full customization of the output formats, units and parameters. The 
export formats can be also saved as profiles for future use. In the installation CD for 
GEMlinkW, there are 2 files named "GEM time - UTM.prf" and "GEM time - Lat 
Long.prf" that are fully transportable export profiles for Waypoint's GrafNav GPS 
software.  
 
If you purchased Waypoint software and wish to use these profiles, copy the files into the 
folder where you installed GrafNav (normally is C:\program files\wayptGPS) and the 
profiles will be ready for use from the export wizard. 
 
NOTE:  
Files copied from a CD into a hard drive always have the 'Read only' attribute. The 
GrafNav profiles will not work properly in this condition. To remove the 'Read only' 
attribute, right-click on the profile files you saved in the hard drive, click 'Properties', un-
check the Read only check box, and click OK. 
 
Note that both GPS and magnetometer times must be in the same units. Since the time of 
the magnetometer file is normally HHMMSS.s UTC, you cannot merge to a GPS file 
with the time in, for example, seconds of the week. The files must not cross over 
midnight since no provisions have been taken to compare the times in such case. 
 
DATA OUTPUT FORMAT AND MERGING OPTIONS: 
New features were added since GEMLinkW 2.4 to adjust the format of the output data . 
The number of decimal places and number of most significant digits (MSD) as well as 
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zero padding can be selected from the Output Format frame. 
 
Selecting the 'Copy' option causes the merged DGPS coordinate to take the same number 
of digits and decimal places as the Mag coordinate that is being replaced but padded with 
zeros if possible. Note that since the DGPS coordinates may have more decimal places 
than the coordinates stored in the Mag memory, this option may truncate the data.  
 
The 'As is' option transfers the DGPS coordinates as they are (i.e. regardless of whether 
they are original or interpolated values) and with no zero padding. Note than interpolated 
values may have a number of decimal places different that the one of the original values 
and result in columns with irregular widths. 
 
Clicking the 'User defined' option activates the drop-downs to select the number of digits 
(MSD) and the number of decimal places, and the option for zero padding. 
 
The formats with no zero padding may display as non-equally aligned columns on a text 
window. However, since each field is delimited by a field separator, the files can still be 
used with plotting and interpretation software (including MSExcel). Formats with correct 
zero padding display as neatly aligned columns which are easier to inspect visually.  
 
On the 'Merging options frame, the 'Overwrite original coordinates' option means the 
Mag's coordinates will be overwritten by the corresponding coordinates of the DGPS file. 
If 'Append at the end of the line' is selected, the magnetometer readings will not be 
modified and the DGPS data will be appended at the end of each Mag's line. The final 
file will therefore have both, the 'Raw" and the DGPS coordinates. 
 
The "Interpolate missing epochs' check box enables or disables interpolation of the DGPS 
data. 
 
If the times of a Mag line and a DGPS line do not match exactly and the interpolate check 
box is checked, the DGPS coordinates will be linearly interpolated from the closest-in-
time coordinates of the DGPS file. The letter 'i' at the end of the line indicates the 
interpolation option was active. 
 
If interpolation is active but the readings are merged directly, the lines will be flagged 
with "i---"  
 
As a measure of the quality of the results, the time interval (in seconds) of the DGPS 
lines used for the interpolation is also added at the end of the line. For example if the time 
interval is 10 seconds, the line will be flagged with "i010". If the DGPS data is at 1Hz, 
the time interval of the interpolation directly represents the number of missing DGPS 
lines or epochs (missing epochs = Time interval / GPS freq). The interpolation is mainly 
intended to generate the coordinates for magnetometers cycling faster than the GPS 
engine. If the time interval excedes 999 seconds, the line will be flagged with "i+++". 
 
If the number of missing epoch is too large, a simple linear interpolation may not produce 
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the desired results. Adjusting the parameters on the DGPS post-processing application 
and analyzing the GPS data is the way to go. 
 
All these settings for output format are saved. The ones used the last time will become 
available when the merging utility starts even after closing GEMLinkW. 
 
Make sure you select a format that suits your data. For example, you should not use the 
same number of decimal places for coordinates in UTM(Universal Transverse Mercator)  
as you would use for coordinates in Decimal Degrees Lat/Long where more decimal 
resolution is needed. 
 
USAGE NOTES: 
After opening a file for the Mag or for the GPS, the program displays the Setup window. 
The text box on the Setup window shows the first 50 lines of the file for your reference.  
 
GPSmerge then checks the selected file to determine the first and last lines of data. The 
fisrt line is defined as the first of 3 consecutive lines with the same length. The last line is 
defined as the line closest to the end of the file that has the same length and number of 
field delimiters as the first. 
 
From the first line of data GPS merge parses the fields based on the current field 
delimiter setting. It uses the values obtained to populate the Time, Coordinate 1 and 
Coordinate 2 dropdowns with the options. 
 
The values of the dropdown boxes are used to determine the position of each field within 
the line and its format. It is not possible to select values other than the ones presented as 
options (from the first line of data). This process will fail or yield unexpected results if 
the fields of the lines are not separated by the selected field delimiter. 
 
When both files are open, the 'Merge' command starts the process. First the files are 
checked to determine if they have readings in common.  
 
If the time intervals from beginning to end of the two files do not overlap, then merging 
is not possible and the process stops. Once again, remember that the files are only 
compared according to their time and the date is not taken into account. Make sure both 
files belong to the same day. 
 
The time extracted from the first data line of the Mag file is compared to the times of the 
DGPS file. If the time of the Mag is not one of the readings in common (i.e. its time does 
not fall within the overlapping time intervals), the data line is passed to the new file. This 
data is tagged with '-RAW' at the end of the line since it does not contain DGPS 
coordinates. 
 
If time stamps match exactly (to the 1/10th of a second), the GPS coordinates are passed 
on according to the overwrite or append selection. If you want to interpolate common 
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readings that do not match exactly, select the interpolate checkbox. 
 
The same process continues with the other lines of the Mag and until the end of the files. 
 
Invalid data lines in the Mag file (such as position labels, comments lines that do not 
contain a valid time format or the field separator) are passed to the new file untouched. If 
the line contains a valid time but some of its values cannot be extracted, you will be 
warned with a message showing the invalid line and the line will pass to the final file 
flagged with 'Error'. 
 
Previous versions of GEMLinkW were less tolerant of invalid data lines in the Base file. 
However, since GEMLnkW 2.4, you are now warned with a message displaying the 
invalid line and the process will continue with the next valid line. To avoid seeing these 
messages, we recommend that you do not edit Base files before dumping (i.e. use them 
exactly as they are dumped from the magnetometer), or export them from the DGPS 
software with the correct format. 
 
At the end of the cycle, a summary message displays the number of readings that were: 
merged directly 
merged using interpolation 
not merged or "Raw" readings.  
The number of time stamps that had correct formats but illegal numbers, such as Hours, 
Minutes or Seconds (if any), are also displayed. 
 
You can use this information to inspect and modify files. However, you must first 
determine in which file the illegal entries are located and their location within the file. If 
the bad time was from the Rover file, it will be in the final file flagged as '****'. The 
same summary is inserted at the end of the merged file.  
 
During the cycle the corrected data is stored in a temporary file named dummy.dmy 
which is created automatically. This file is saved even in the event of a fatal error.  
 
To recover the data you have corrected so far, you should open the dummy file which is 
located in the folder in which GEMLinkW is installed. The dummy.dmy file is 
overwritten with no warning when a new correction cycle begins. 
SAVING THE DATA: 
When exiting the utility, you are asked to save the final file. This process simply renames 
the dummy file to the path and file name of your choice. In the event of an error when 
saving (for example, when the path or drive is not available), the program will display a 
message indicating that your merged data is still available in the dummy.dmy file and 
showing its location. Should you decide to cancel and exit without saving/renaming the 
file, the dummy file will remain intact. 
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Note that some other GEMLinkW tools use the same dummy.dmy file. Always save or 
rename your file to avoid loosing the data. 
 

3) COORDINATE CONVERSION 
I. Convert coordination in file 

The Coordinate Conversion utility is intended to convert the coordinate system of the 
data contained in a file. The supported coordinate systems are geodetic (latitude and 
longitude) and Universal Transverse Mercator (UTM). 
 
Conversion to a different datum is also supported and it is calculated using the Standard 
Molodensky transform. 
 
The utility creates a new file with the converted coordinates. Optionally, the file may 
contain both the original and the converted coordinates. 

  
FILE NOTES: 
The files must be ASCII text files. The end of each line of text must have a CR (carriage 
return) or CRLF (carriage return/Line feed). Lines terminated only with LF cannot be 
used since they are treated as a single one.  
 
The default delimiter between fields or columns is SPACE. A different delimiter can be 
selected from the 'Field Delimiter' menu under the 'File menu'. The selection is not a 

北
京
欧
华
联
科
技
有
限
责
任
公
司



 2

permanent setting. SPACE is the default delimiter each time GEMLinkW opens.  
 
DATA INPUT FORMAT AND UNITS: 
Geodetic input coordinates must be in Decimal Degrees (D.d). There is no limit to the 
number of decimal places. However the values must fall within the accepted ranges. 
These are 
-80.5 to 84.5 degrees for LATITUDE where '-' represents WEST  
-180 to 180 degrees for LONGITUDE where '-' represents SOUTH 
 
UTM input coordinates are in meters (M.m). There is no limit to the number of decimal 
places and the accepted ranges are 
100,000 to 900,000m for EASTING  
0 to 10,000,000m for NORTHING  
1 to 60 for UTM zone 
When the input is in UTM, the UTM zone and the hemisphere must also be supplied. 
 
DATA OUTPUT FORMAT AND UNITS: 
The units of the converted coordinates are 
Decimal Degrees (D.d) for geodetic output coordinates  
Meters (M.m) for UTM output coordinates. 
The number of decimal places and number of most significant digits (MSD) as well as 
zero padding can be selected from the 'Output Format' frame. 
 
Selecting the 'Auto' option causes the converted coordinates to take the appropriate 
number of digits and decimal places that suit the output coordinate system.  
The Auto output formats are: 
DDD.dddddddd for geodetic coordinates  
MMMMMMM.mmmm for UTM coordinates. 
both padded with zeros.  
 
The 'As is' option transfers the converted coordinates in the format they are calculated. 
The number of decimal places of each value may vary and this could result in columns 
with irregular widths. 
 
Clicking the 'User defined' option activates the drop-downs to select the number of digits 
(MSD) and the number of decimal places, and the option for zero padding. 
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The formats with no zero padding may display as non-equally aligned columns on a text 
window. However, since each field is delimited by a field separator, the files can still be 
used with plotting and interpretation software (including MSExcel). Formats with correct 
zero padding display as neatly aligned columns which are easier to inspect visually.  
 
On the 'Output options' frame, the 'Overwrite original coordinates' option means the 
original coordinates will be overwritten by the corresponding converted coordinates. If 
'Append at the end of the line' is selected, the original values will not be modified and the 
new coordinates will be appended at the end of each line. The final file will therefore 
have both, the original and the converted coordinates. 
 
USAGE NOTES: 
Click on the 'Open' button and select the file that contains the coordinates you want to 
convert. The program displays the Setup window. The text box on the Setup window 
shows the first 50 lines of the file for your reference.  
 
The selected file is then checked to determine the first line of data. The first line is 
defined as the first of 3 consecutive lines with the same length.  
 
From the first line of data the utility parses the fields based on the current field delimiter 
setting. It uses the values obtained to populate the Latitude/Easting and 
Longitude/Northing dropdowns with the options. 
 
The default delimiter between fields or columns is SPACE. A different delimiter can be 
selected from the 'Field Delimiter' menu under the 'File menu'. The selection is not a 
permanent setting. SPACE is the default delimiter each time GEMLinkW opens. 
 
Click the 'OK' button to accept your selections. The range of the selected values are 
checked according to the expected ranges. For example, if you are converting from UTM 
to Lat Lon, your selections must fall within the range of the UTM input coordinates (see 
DATA INPUT FORMAT AND UNITS above). 
On the conversion frame, check the 'Lat Lon to UTM' or the 'UTM to Lat Lon' option 
buttons to determine the direction of the conversion and the range of the input 
coordinates. If you enter UTM to Lat Lon you must also provide the UTM zone and the 
hemisphere. 
 
NOTE: 
The validity (see Input format and Units) of the selected fields is checked only during the 
setup and before the conversion cycle begins. Since the selected values are obtained from 
the first line of data of the file, this means that only the first data line of the file is 
checked for compliance. It is assumed that all the following lines of the file will contain a 
valid entry in the selected column. Make sure that the file meets this assumption to avoid 
incorrect results. 
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GEODETIC DATUMS: 
Three built-in datums are available from the 'Input datum' and 'Output datum' dropdowns 
WGS84  a = 6378137  1/f = 298.257223563  dx = 0  dy = 0  dz = 0  
NAD27  a = 6378206.4  1/f = 294.9786982  dx = -8  dy=160  dz = 176  
SAD69  a = 6378160  1/f = 298.25  dx = -60  dy = -2  dz = -41  
The default datum for both input and output is WGS84.  
 
If none of this datums apply to your data, you may define up to two custom datums. To 
do this, select Custom 1 or Custom 2 from the datum dropdowns. You must then enter 
five parameters to define the datum. The parameters are:  
Semi-major axis (a)  
inverse flattening (1/f)  
x, y, z deviation from WGS84 in meters (dx, dy, dz) 
You may also enter a name to identify your custom datums. The name must not exceed 
20 characters. 
 
These datum parameters and the name are saved and will be available next time you use 
the utility. If you change the definition of this datums, the previous values will be 
overwritten. 
 
 
When all the selections have been made click the 'Convert' button to start the cycle.  
 
During the cycle the converted data is stored in a temporary file named dummy.dmy 
which is created automatically. This file is saved even in the event of a fatal error.  
 
To recover the data you have corrected so far, you should open the dummy file which is 
located in the folder in which GEMLinkW is installed. The dummy.dmy file is 
overwritten with no warning when a new conversion cycle begins. 
 
SAVING THE DATA: 
When exiting the utility, you are asked to save the final file. This process simply renames 
the dummy file to the path and file name of your choice. In the event of an error when 
saving (for example, when the path or drive is not available), the program will display a 
message indicating that your merged data is still available in the dummy.dmy file and 
showing its location. Should you decide to cancel and exit without saving/renaming the 
file, the dummy file will remain intact. 
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Note that some other GEMLinkW tools, such as the merging utility (GPSmerge) or the 
Diurnal correction utility, use the same dummy.dmy file. Always save or rename your 
file to avoid loosing the data. 
 
IMPORTANT NOTES: 
The fact that the number of decimal places can reach or exceed 0.0001m or 0.00001sec 
does not imply that the precision of the calculation is such. The actual accuracy of the 
result could be less depending on the selected datum and their error estimate.  
The validity of the selected fields is checked only during the setup and before the 
conversion cycle begins. Since the selected values are obtained from the first line of data 
of the file, this means that only the first data line of the file is checked for compliance. It 
is assumed that all the following lines of the file will contain a valid entry in the selected 
column. Make sure that the file meets this assumption to avoid incorrect results. 
Different datums normally apply to certain geographic areas. This utility does NOT 
check for compatibility of datum and input coordinates. Make sure the coordinates are 
within the area of coverage of the selected datum. 
Example of create a new datum and convert it: 1. Open GEMLink,click menu "Tools"--> "Corrdinate conversion"-->"Convert Coord in 
File" 
It will show the window as following. 
 

  
2. Select file that contains WGS84 coordinates by clicking button “open”. 
 
3. Select “Latitude”, “Longitude”,  “Input Datum”(here is WGS84), “Output 
Datum”(here is Custom1, a Define Custom Datum window will show, please fill related 
parameters to local  PSAD datum). Take Brazil as example here: 
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Semi-Major Axis: 6378388  
Inverse Flattening: 297 
X-axis translation -291.87  
Y-axis translation 106.37 
 Z-axis translation -364.52  
 
4. Select “Coordinate Conversion”’ as “Lat Lon  Lat” 
 
5. Click button “OK”, it will change to “Conver”, click it. A output option will show, 
select as you want. 

  If there is no error, click “exit”. 
A dialog will pop up let you save the result file. The converted datum should be 
appended to every line end. 
 
Result: 

 
 

II. Coordinate Calculator 
Coordinate Calculator is to exchange between individual geographic coordinate and 
UTM coordinate. The function will be effective by inputting the data and pressing arrow 
button. User can select different coordinate Datum to do the change. 
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4) RS232 Transfer 
I. Receive DGPS BINARY 

This utility has been designed to safely transfer the DGPS binary data from the memory 
of GEM Systems' magnetometers equipped with on-board GPS and with post-processing 
option, to a file on the PC. 
The binary DGPS data is stored in the magnetometer's memory during surveys with GPS 
when the post-processing option is enabled. 
 
The previous versions of GEMLinkW captured the binary DGPS data to a file using File 
Capture in binary mode (F5). While this worked well with 2 or 3 MB files, the Windows 
environment proved to be unreliable for larger files. DGPS binary files may be much 
larger than 2 or 3 MB and in those cases, part of the data was lost during the transfer even 
at low rates. 
 
While the File Capture in binary mode is still available in GEMLinkW 2.4, the use of the 
new DGPS Binary Data Transfer utility is strongly recommended. 
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USAGE NOTES:  
To access the utility click the 'Tools' menu, point to 'RS232 transfer' and then click 
'Receive DGPS binary' on the GEMLinkW menu bar.  
 
To dump the DGPS binary data, follow the step-by-step instructions provided by this 
utility. These instructions correspond to the latest release of software for the 
magnetometers 

II. TRANSFER GPS WAYPOINTS  
 
This utility is intended to transfer the coordinates of survey waypoints from a PC text 
(ASCII) file to GSM-19 or GSMP-30 v6.0 consoles equipped with on-board GPS and full 
lane guidance option. 
 
The text files may be created using GEMlinkW in editing mode, or with any other word 
processor capable of saving as plain ASCII text. Spreadsheet programs such as Microsoft 
Excel can also be used provided the files are saved as text (space, comma, TAB , or colon 
separated) and not as worksheets or workbooks. 
 
After creating the text file on the PC, just follow the step-by-step instructions provided by 
this utility. These instructions correspond to the latest release of software for the 
magnetometers. 
 
If any of the steps don't match the options or screens available from your unit, it is either 
because your unit does not support the waypoint feature or you have an older software 
version. Please contact GEM Systems for assistance. 
 
To ensure proper data transfer, the following file formatting is required.  
 
 
TEXT FILE REQUIREMENTS: 
 a) General considerations  
The files must have two columns; one for each coordinate of the waypoints. The default 
delimiter between fields (or columns) is SPACE. A different delimiter can be selected 
from the 'Field Delimiter' menu under the 'File' menu. The selection is not a permanent 
setting. Space will be the default delimiter each time GEMlinkW opens. Consecutive 
separators will be treated as a single one. 
 
The magnetometer consoles can store up to 1000 waypoints. Therefore, the files should 
have 1000 (or less) lines or rows. However, if the file is larger only the first 1000 lines 
will be transferred. The end of each line is determined by a CR (carriage return) or CRLF 
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(carriage return/Line feed). Lines terminated only with LF cannot be used since they are 
treated as a single line. 
 
A general condensed description of the file format follows: 
Coord1WPoint1  Separator  Coord2WPoint1  CRLF  
Coord1WPoint2  Separator  Coord2WPoint2  CRLF  
Coord1WPoint3  Separator  Coord2WPoint3  CRLF  
|  |  |  |  
|  |  |  |  
Coord1WPoint1000  Separator  Coord2WPoint1000  CRLF  

Separator is space. 
The coordinates of the waypoints can only be entered as UTM.  
Use the option buttons “Meter” or “Centimetre” in 'Unit of UTM' to select the units of the UTM 
coordinates of your file. 
 
Then next sections describe the format expected for the coordinates when entered as UTM. 
 
 
 
b) UTM coordinates 
 
The first column of the file represents the Easting and the second the Northing coordinates of the waypoint. 
The units are meters and decimal fractions are rounded to the nearest whole number. Negative numbers are 
rejected. The maximum allowed value for Easting or Northing is 9999999 whether this represents a valid 
coordinate or not.  
 
The following is an example of valid UTM coordinates in meter for waypoints with SPACE as field 
delimiter between columns.  

629260 4857196  
629268 4857195  
629271 4857194  
629361 4857194  
629262 4857192  
 

III. PROGRAMMABLE BASE 
Optionally, Version above v6.0 GEM Systems magnetometers may be equipped 
with a Programmable Base Station feature. The programmable base allows 
entering up to 30 base station survey programs or schedules.  
 
Each schedule contains the date and time in which the survey starts and the date 
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and time in which the survey ends. These dates and times can be entered 
directly using the unit's keypad or you can also use this utility to transfer them to 
the unit from a text file on your PC through the RS232 link. 
 
The text files may be created using GEMlink in editing mode, or with any other 
word processor capable of saving as plain ASCII text. Spreadsheet programs 
such as Microsoft Excel can also be used provided the files are saved as text 
(space, comma, TAB, or colon separated) and not as worksheets or workbooks.  
 
After creating the text file on the PC, just follow the step-by-step instructions 
provided by this utility. These instructions correspond to the latest release of 
software for the magnetometers. 
 
If any of the steps don't match the options or screens available from your unit is 
either because your unit does not support programmable base mode or you have 
an older software version. Please contact GEM Systems for assistance. 
 
To ensure proper data transfer, the following file formatting requirements must be 
met. 
 
 
TEXT FILE REQUIREMENTS: 
 
1. General considerations  
The files must have two columns; one for Start and the other for the Stop date 
and time. The default delimiter between fields (or columns) is SPACE. A different 
delimiter can be selected from the 'Field Delimiter' menu under the 'File' menu. 
The selection is not a permanent setting. SPACE is the default delimiter each 
time GEMlink opens. Consecutive separators will be treated as a single one. 
 
The magnetometer consoles can store up to 30 programs or schedules. 
Therefore, the files should have 30 (or less) lines or rows. However, if the file is 
larger only the first 30 lines will be transferred. The end of each line is 
determined by a CR (carriage return) or CRLF (carriage return/Line feed). Lines 
terminated only with LF cannot be used since they are treated as a single line. 
 
A general, condensed description of the file format may be written as follows: 
Start date and time   Stop date and time   
    
YYMMDDhhmmProg1  Separat

or  YYMMDDhhmmProg1  CRLF  

YYMMDDhhmmProg2  Separat
or  YYMMDDhhmmProg2  CRLF  
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|  |  |  |  
|  |  |  |  
YYMMDDhhmmProg3
0  

Separat
or  

YYMMDDhhmmProg3
0  CRLF  

 
 
The columns must have date and time entered as YYMMDDhhmm (Year, Month, Day, hours, 
minutes) with the hours in 24hr format.  

 MM for the month cannot exceed 12,  
 DD for the day cannot exceed 31,  
 hh for the hour cannot exceed 23 (24:00 is not accepted as midnight),  
 and mm for the minutes cannot exceed 59.  

 
 
Invalid entries for months, days, hours or minutes will be rejected. A message will indicate on which line 
the invalid entry has been detected so you can edit the file and correct the error. 
 
For example if you are using SPACE as field separator, and want to automatically start the base on May 20 
2002 at 11:30 AM and stop it on May 25 2002 at midnight, you should enter the line as: 

0205201130 0205252359 (file will be 1min short) or  
 
0205201130 0205260000  

Note that the date of the schedules only includes 2 digits for the year. When the 
Stop time is found to be BEFORE than the Start time (Stop in the past as 
compared with the Start time), you will be prompted to accept or reject the entry.  

IV. Software upgrade 
GEM Systems Inc magnetometer software which is above v6.0 can be upgraded from a PC using the unit's 
6-pin connector for the RS-232 port, and the cables supplied for file transfer. The Upgrade utility provides 
all the functionality required to upload the new software to the unit.  
 
To avoid hardware/software incompatibility, the source software files are released as required and normally 
named as the serial number of the unit with extension '.bin'. 
 
The Upgrade tool will only upload the software if the embedded serial number of the source file exactly 
matches the serial number of the unit. 
 
If you have been supplied with a new software version, just make it available to this utility from any 
directory or drive of your computer. 
 
Connect the RS-232 of your console to the active serial port of the PC where you are currently running 
GEMLinkW, and follow the instructions provided by the upgrade utility. 
You will find step by step information on how to proceed with software upgrades in 
GEM Systems website .  
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Please click here for a direct link to the information.  
 

5) Datum Adjustment 
1. Open Datum Adjustment window 

Click Menu "Tools"-->"Datum Adjustment". The following window will be 
shown. 

 
  

2. Load file and Set parameter 
Click Menu "File" --> "Open" to select airborne log file and open it. 
Text box will show the first 50 lines of the file content. 
Select Altitude Field from the below Combobox and enter the adjustment 
parameter. Datum adjust can be done with fixed adjustment parameters or other 
data column selected by the Combobox. Operator can support “+”/”-”/”*”/”/”. 
Adjusted result column’s position is followed altitude field by default. But user 
still can assign a position index by selecting group radio button "Insert new 
column at" and new column index. The adjusted value will use the same string 
format as the “Select Da.tum Field” 
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If the Datum shows value abnormal, it’s probably that the Field Delimiter needs 
to be changed. Please click menu  "File "-->  "Field Delimiter " to change it. 
  

3. Start adjustment 
Click button "Adjust". The progress bar in the bottom will show the progress of 
the adjustment. Program will calculate the altitude plus the adjustment value and 
insert it into the new column. 
After processing finished, a save file dialog will be popped out and ask user to 
save the result. 
  
  

4. Check the adjusted log 
Click button "Close". Click GEMLink’s main window Menu "File" --> "Open" . 
Select the adjusted log file to check the adjusted result. 
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6) Data Sign Flip 
Data Sign Flip function is to change the sign of data like VLF in-phase data when 
survey direction is turned around. 

  
1 Set Data columns 
Open Data Sign Flip window from menu “tools”-> “Data Sign Flip”. 
Set correct delimiter for data string, then load data file by menu file->Open. 
Select data from column for “Latitude”, “Longitude”, “Yaw”, “Data1” and 
”Data2”.  
“Latitude”, “Longitude”, “Yaw” are for the condition that can help user to select 
survey points which data is needed to be flip the sign. 
“Data1” or “Data2” are the column that user want to flip the sign and one of them 
must be selected at least. 
Button “Load to Graph” is for drawing graph for coordinates survey lines, Yaw 
data and Data1/Data2. 
Button “Reset all” is for clear the graph, table and points selected. 
 
2 Set Yaw conditions for survey points data 
There are two general conditions that user can set for this function to select data, 
one is to set Yaw condition and the other is set line’s begin point and end point. 
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If survey has yaw information, user can use “Yaw” as direction to determine 
which line is needed to be changed.  There are two yaw condition which can be 
combined by “And” or “Or”. The basic condition supports following formula: 
“=”: equals, 
”!=”: does not equal, 
“>”: is greater than 
“>=”: is greater than or equal to 
“<”: is less than 
“<=”: is less than or equal to 
Button “Select”: after yaw condition set, click “Select” will mark those points by 
circle in graph which match the criteria and “selected” in data grid will be ticked. 
Button “Deselect”: this function can removed the selection which match the 
criteria. 
3 Set start-end point of lines as condition 
Radio button “Select begin point” and “Select end point”: if any of these two 
radio button clicked, user can pick begin point and end point at right graph of 
GPS coordinate, Yaw, Data1/Data2 graph. 
Button “Select”: after yaw condition set, click “Select” will mark those points by 
circle in graph which match the criteria and “selected” in data grid will be ticked. 
Button “Deselect”: this function can removed the selection which match the 
criteria. 
4 Sign flip result 
Raw data will be kept and sign flip data will be copied to a new column. 
User can decide the sign flipped data inserted to the place after Data1/Data2 or at 
a new column set by dropdown combo box. 
User can decide the result file’s directory by setting the result file name click the 
right directory button. 
Button “Flip Sign & Save File”:  this function will perform the sign flip process 
for selected points’ data and save to the file. 
 

北
京
欧
华
联
科
技
有
限
责
任
公
司



 4

7) File Converted as  
This tools is to convert Magnetometers log file to following file content format: 
1 Geosoft XYZ file 
Geosoft XYZ file contains line, X,Y, Z information which can be selected from 
dropdown combobox as following picture. 
User click Menu “File”“Open” to select mag’s log in GEMLink. With right 
field delimiter setting,   User can set the X,Y, Z and line marker value from the 
magnetometer’s log file. Set click right button of the converted file text box to set 
the new XYZ file name. 
Click button “Convert”, GEMLink will generate the Geosoft XYZ file. 

 
8) Data Format Cleanup 
It can help you to clean up the data format, removing empty space at the 
beginning and end of line, remove empty lines, replace "/line" to "line", change 
end of line sign. 
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4.1.7 Graphing Menu functions 

 Note: GEMLink is free software and its graphical function is to provide some level 
information. Please purchase other commercial software for your official usage.  

1) Graph Profile 
This new GEMLink utility provides basic profile plots of magnetic data. To access the 
utility, use the 'Graph Profile' menu under 'Tools' or the shortcut Ctrl+G 
 

 
 
OPENING A FILE FOR PROFILE  
The profile utility reads the files from their location in the computer. Files that are visible 
on the text window but have not yet been saved to a disk file cannot be opened for 
profiles. 
 
The files must be ASCII text files. The end of each line of text must have a CR (carriage 
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return) or CRLF (carriage return/Line feed). Lines terminated only with LF cannot be 
used since they are treated as a single one. 
 
The files can be accessed in 2 different ways 
From the text window  
From the profile window  
Initially, the disk files opened from the text interface are transferred to the profile utility 
interface. Opening, saving or closing a disk file in the text window, clears the existing 
profile(s) and updates the grid of the profile window. 
 
However, files can be opened independently from the profile window without affecting 
the file displayed on the text window. To do this, use the profile window 'Open' menu 
under 'File' or the Ctrl+O keyboard shortcut. 
This is specially suited for large files which would take time and memory resources to 
open and display as text, but can be plotted when accessed from the profile window. 
 
 
Once a file is open for plotting, it is checked to determine its first and last lines of data. 
The first line is defined as the first of 3 consecutive lines with the same length. The last 
line is defined as the line closest to the end of the file that has the same length and the 
same number of field delimiters as the first. Then, the first data line is displayed on the 
grid. The columns of the grid are populated with the fields from the line. 
 
The default delimiter between fields or columns is SPACE. If the lines are delimited by a 
different character the columns of the grid will not be evenly populated. Rather, all fields 
of the line will appear together in the first column. A different delimiter can be selected 
from the 'Field Delimiter' menu under the 'File menu'. The selection will be save as a 
permanent setting, it means it is still effective next time you use GEMLink. 
 
TO DRAW A PROFILE 
Profiles can be single or stacked. 
LEFT-click on the desired column of the grid to draw a single profile. 
RIGHT-click on the grid to add a stacked profile with different colour. 
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NOTES:  
Colours of stacked plots change in a sequence and a label indicates the colour of the 
active plot (the last plot of the stack) 
Statistics such as Max and Min values, correspond to the active plot (the last of the 
stack).  
If Auto scale is enabled, the previous profiles will be not to scale. Y axis scale will 
correspond to the active plot (the last of the stack). The benefit of this scaling method is 
that total magnetic field and gradient for example, can be visualized superimposed 
despite the normally large difference of the values. 
Resizing the window or autoscaling the plot will clear the old profiles and only the 
current one (last of the stack) will be redrawn. 
If a file is too long and the maximum number of points on the profile is exceeded, some 
points may be skipped. For example, every second or third point will be transferred to the 
profile. "X step" in the statistics area of the profile window represents the number of 
points plotted and the ones left behind.  
 
 
TO CHANGE SCALE 
The scale of the Y axis can be adjusted automatically or manually. Use the 'Auto scale' 
menu or the Ctrl+A keyboard shortcut to enable and disable auto scaling. 
 
If the 'Auto scale' menu is checked the Y scale adjusts automatically with each new single 
or stacked plot. 
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Use the 'Force auto scale' button in the statistics area to auto scale the profile at any time 
regardless if the auto scale setting is ON or OFF. 
 
If 'Auto scale' menu is not checked, the Y axis scale is constant and it can only be 
changed manually. 
 
To adjust the Y scale manually use the 'Y Min/Max' menu or the Ctrl+Y keyboard 
shortcut and enter the desired scale in the Y axis scale window. 
 
You may also increase or decrease the Y axis scale by right-clicking on the slider or by 
dragging its cursor. 
 
NOTES:  
If you right-click or drag the slider while pressing the SHIFT key, the profile will be 
shifted up or down without affecting the Y scale. 
Re-scaling, shifting or resizing the profile window, will redraw the current plot but 
previous, stacked plots will be cleared. 
Plot menu also available right clicking on the plot  
 
 
PROFILE STATISTICS 
The statistics area of the profile window shows Y axis scale in units/division, the 
maximum and minimum values of the Y axis, the maximum and minimum values of the 
profile, and the value at the current point. 
 
Right click on plot to see values of the active plot at the click point. Right click and drag 
to see values of active plot changing along with the mouse position. 
 
TO ZOOM IN 
Press SHIFT, right click and drag the mouse over the part of the plot you want to zoom. 
The message 'Partial Plot" will be displayed on the statistics area to remind you that only 
part of the file is currently displayed. 
 
TO ZOOM OUT 
Use 'Zoom out' menu or the Ctrl+Z keyboard shortcut to redraw the profile of the entire 
file. 
 
NOTE:  
Zoom out redraws only the current active plot for the entire file. Old, stacked plots will 
be cleared. 
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Plot menu also available right clicking on the plot  
  

 
TO FIND A POINT OF THE PROFILE IN THE TEXT WINDOW 
Place the mouse pointer on the desired point of the profile. Right-click while holding 
shift pressed. 
The line of data containing the selected point of the active profile will be located in 
GEMLink's text window.  
 
NOTE:  
If the files of the profile and text windows are different, you will be prompted to open the 
current profile file as text.  

 
 
 
TO CHANGE PLOT STYLE 

You can change the style of the profile line using the 'Style' menu. The options 
are 

o Line: joins points with a continuous line  
o Points: each point is shown separately with a marker  
o Line and point: combines line and point markers  
o Pen# sets different thickness of the line and/or the point markers 

NOTE:  
Changing plot style or pen size will redraw only the active plot. Stacked plots will be 
cleared. 

  
 
TO REVIEW A FILE 
Press and hold "F" and click on the desired column of the grid to start scrolling the 
profile FORWARD. 
 
Press and hold "B" and click on the desired column of the grid to start scrolling the 
profile BACKWARD. 
 
NOTES:  
Scrolling file review from a partial (zoomed) plot starts at the current left-most point of 
the profile.  
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To start the file review from the beginning of the file zoom out the plot or begin scrolling 
immediately after opening the file for profiling. 
You can set the number of points of a scrolling profile with the 'X axis', 'File review' 
menu. The default value is 250 points (or 50 points/div). 

 
 
TO PRINT / SAVE PROFILE 
Use the 'Print' menu to print the profile window. The image quality is better when 
printing large or maximized windows. 
 
Use the 'Save' menu to save the profile window as a bitmap. The image quality is better 
when printing large or maximized windows but saved file becomes larger. 
 
NOTES:  
Saved profiles may be viewed/opened with MS Paint or any other application capable of 
handling bitmap graphics. 
You may use GEMLink's ZIP utility to compress saved bitmaps. 
ADDITIONAL HELP 
Use the 'Commands list' menu or the keyboard shortcut F2 to open a reminder of the 
profile window commands. 
 
You may also use the mouse pointer help. Make sure the 'Mouse pointer help' menu is 
checked. Then position the mouse over a control of the profile and wait for a description 
of the control to pop up. 
 

2) Contour/Surface Graph 
Open contour window by GEMLink Menu “Graphing””Contour graph” 
This function is to draw a contour graph for MAG value with GPS coordinates. 
A basic magnetic map plotting feature is added as shown below.  
 
The default delimiter between fields or columns is SPACE. A different delimiter can be 
selected from the 'Field Delimiter' menu under the 'File menu'. . The selection will be 
saved as a permanent setting, it means it is still effective next time you use GEMLink. 
After right delimiter is selected, user can select field Longitude(or UTMX), Latitude(or 
UTMY) and Magnetic(or Gradient) from dropdown combo box. Click button ‘OK’, 
contour graph of MAG with coordinates will be shown with default graph resolution of 
200.Please change it to the value adapted to your survey range. 
In order to get a more discrimination picture, contour function will check the smaller 
value and generate a gradient picture basing on that value. 
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  Contour Parameter Setting: 
Longitude: Longitude coordinates or UMTX 
Latitude: Latitude coordinates or UMTY 
Magnetic: Mag value or Grad value 
Gallery type: Contour or Surface, Surface is 3D graph. 
Graph resolution: better to set from 50-200. The calculation time is longer with the 
bigger graph resolution number. Please change it to the value adapted to your survey 
range and graph requirement. 
Color resolution: 1-255, higher value with more color for Magnetic value  
Color opaque: 1-255, higher color opaque means with less transparent. 
Base Value: It uses inputted value as background color’s Magnetic value. 
Smooth in range: If selecting the check box, software will generate smooth picture with 
range value. 
Contour Lines: If selecting the check box, contour line will be displayed. If the color can 
not give a clear image, please select it. 
Grid Line: If selecting the grid line for latitude and longitude will be displayed. Default 
not enabled. 
Example of contour graph 
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3) Real-time Graph 

I. MAGs Real-time Graph-- User-defined Multiple Channel Real-time Data 
Plotting 

As shown below, users can capture real-time sampling on main window while plotting on other windows simultaneously. User can select the columns to monitor magnetic fields simultaneously up to four channels. By changing the Min/Max values manually, the plot can be zoomed in/out.  It is very useful to set up, tune system.  
It can show up to 600 points historic data. If set interval time in menu ‘setting’’Update interval’ to 1000ms, totally 10 minutes data can be seen in one graph. If set interval time in menu ‘setting’’Update interval’ to 100ms, totally 1 minutes data can be seen in one graph. 
Note: it’s not recommended to set update interval below 100ms, the first reason is most MAG data from serial port is slow than 100ms per data sentence, the second is Windows platform is not real time system, windows  timer below 100ms may not be so accuracy. 
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II. GRAD Real-time Graph 

As shown below, users can capture real-time sampling of M1 and M2, application will calculate Diff1(M1-M2) or Diff2(M3-M4) which means GRADs value between MAGs. The GRAD value show to user on right of main window while plotting on other windows simultaneously. User can select the columns to monitor magnetic fields simultaneously up to four channels. By changing the Min/Max values manually, the plot can be zoomed in/out.  It is very useful to set up, tune system.  
It can show up to 600 points historic data. If set interval time in menu ‘setting’’Update interval’ to 1000ms, totally 10 minutes data can be seen in one graph. If set interval time in menu ‘setting’’Update interval’ to 100ms, totally 1 minutes data can be seen in one graph. 
Note: it’s not recommended to set update interval below 100ms, the first reason is most MAG data from serial port is slow than 100ms per data sentence, the second is Windows platform is not real time system, windows timer below 100ms may not be so accuracy. 
北
京
欧
华
联
科
技
有
限
责
任
公
司



 5

  
 

4) Stack graph 
For some application such as VLF, it may need to plot stacked or mirror pictures to tune or adjust sensors & systems. The stack graph is for this feature. After loading MAG and VLF log data file, select proper delimiter, Log file first data line will be shown in the grid.  Take following log as example, the ‘Stack Column’ is referred to VLF IP value’s column, the ‘Reference Column’ is referred to station index of one line, the index will increase from 0 to 30 and go back to 0 for every reading.  After selecting the column, then press ‘Confirm’, Graph will draw a picture of In-phase value picture with the index of station like below.  /Gem Systems GSM-19WV 8032671 v7.0 25 IX 2008 M ewv6fl.v7vbs                        /ID 1 file 03survey.v2  15 II 00 / /Time       Line        Station         Slope   Freq  IP        OP      H1    H2   SS 002135.3 00000S  0000000 S   0000N  24.0 +017.3 -015.2  016  051 027.33 002201.3 00000S  0000001 S   0000N  24.0 +024.5 -013.4  011  057 029.62 002214.3 00000S  0000002 S   0000N  24.0 +014.6 -005.1  008  069 035.63 ...... ...... 002538.3 00000S  0000026 S   0000N  24.0 +011.2 +005.9  032  092 050.09 002546.3 00000S  0000027 S   0000N  24.0 -040.3 +003.0  016  084 043.96 002554.6 00000S  0000028 S   0000N  24.0 -064.8 -000.7  008  064 033.08 002602.5 00000S  0000029 S   0000N  24.0 -064.3 -001.3  004  054 028.00 002610.9 00000S  0000030 S   0000N  24.0 -059.1 +000.6  005  050 026.06 002624.9 00001S  0000030 S   0000N  24.0 -061.3 -000.4  001  054 027.55 002633.8 00001S  0000029 S   0000N  24.0 -064.8 -001.1  004  057 029.30 002642.1 00001S  0000028 S   0000N  24.0 -067.0 -001.0  004  065 033.37 002650.5 00001S  0000027 S   0000N  24.0 -050.8 +001.5  011  082 042.11 002659.7 00001S  0000026 S   0000N  24.0 -013.0 +006.1  020  097 050.63 ...... ...... 
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003009.5 00001S  0000003 S   0000N  24.0 -031.0 +013.5  048  118 032.42 003021.8 00001S  0000002 S   0000N  24.0 -012.3 +004.4  054  127 035.29 003031.6 00001S  0000001 S   0000N  24.0 +016.5 -007.3  020  062 033.12 003040.7 00001S  0000000 S   0000N  24.0 +019.2 -013.6  016  052 028.00  

  
1) Attitude 3D Graph 

If customer’s system has attitude sensor, like VN-100 Rugged IMU. 
GEMLink can show the real-time 3D graph as below, users can see real-time sampling on main window while plotting on other windows simultaneously. User can select the columns to monitor Yaw, pitch, roll simultaneously. 
Three vector mapping to axis: 
Yaw-rotate around Z axis 
Pitch-rotate around Y axis 
Roll-rotate around X axis 
On the right of graph, user can adjust the column index of the original raw data to get the exact value, and the delimiter can be selected in the radio button group. 
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The chart below the graph is record for the history data for attitude value. By changing the Min/Max values manually, the plot can be zoomed in/out.  It is very useful to set up, tune system.  
It can show up to 600 points historic data. If set interval time in menu ‘setting’’Update interval’ to 1000ms, totally 10 minutes data can be seen in one graph. If set interval time in menu ‘setting’’Update interval’ to 100ms, totally 1 minutes data can be seen in one graph. 
Note: it’s not recommended to set update interval below 100ms, the first reason is most MAG data from serial port is slow than 100ms per data sentence, the second is Windows platform is not real time system, windows  timer below 100ms may not be so accuracy. 
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4.1.8 Waypoint Plan functions 

GEMLink waypoint function includes function “Waypoint Plan” and “Waypoint 
Tracking”.  
“Waypoint Plan” is for customer to automatically generate survey points by quick 
polygon drawing function. Detail function will be listed below.  

 
1) Waypoint file operation 

Load WP File: Load saved waypoint file into edit map, file name will be shown at the 
right text box of same menu bar. 
 
Save WP File: Save current edit waypoint into opened file. If there is no opened file, a 
save dialog will be popped up for user to set file directory and file name. 
 
Save to UTM WP File: Convert all current waypoints’ GPS coordinate to UTM file in 
meter. GEMLink can transfer those UTM point into console by menu function “Tools-
>RS232 Transfer->Transfer GPS Waypoints->PC To Console” 

2) Waypoint file general rules 
WP Check ALT: Enable altitude check for waypoint, this is usually used in airborne or 
UAV survey work. 
 
WP Radius(m): If survey point GPS coordinate is inside the radius of the waypoint 
circle, waypoint Passed will be set to true 
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Default Alt(m): When click map and add new waypoint into the list, this value will be 
default set as waypoint’s altitude 
 
Alt Type: can be set to AGL(above ground level) or GPS, this value will indicate user 
when they are using function Waypoint Tracking, which altitude should be used to 
monitor the survey line. 

3) Waypoint list operation 
Add below: add new waypoint at the current select waypoint, then input GPS coordinate 
by manual 
 
Delete Current: delete current select waypoint 
 
Clear All: clear all way point 
 
Move Up: exchange previous waypoint position with current select waypoint 
 
Move Down: exchange following waypoint position with current select waypoint 
 
Check All Passed: make all waypoint Passed checked, and that waypoint’s color will be 
set to green. If all waypoints reached, whole survey line path’s color will be set to green. 
 
Uncheck All Passed: make all waypoint Passed un-checked, if anyone of the waypoints 
is set to unchecked, the survey line path’s color will be set to red. 
 
Mouse Righ click: mouse right click will pop up menu for waypoint operation and 
polygon point operation 
 
Mouse Left click: mouse left click will make a new waypoint basing on mouse point’s 
GPS coordinate and with the default Alt set mentioned above. 
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WayPoint grid list: Except Index, Waypoint information can be shown and changed 
directly in the grid view list. Waypoint provides Tag(waypoint name), Passed(Real 
Survey line passed this waypoint), latitude, longitude and altitude. 

4) Map operation 
Internet is need to download map content at the beginning, but GEMLink provides 
map prefetch and download function to cache the map inside your PC’s disk for offline 
usage. 
Please be ware that there could be some GPS coordinate offset or difference between the 
Map and the real world.  
 Map source: select Map content provided in the combo box like Google, Yahoo!, Bing, 
OpenStreetMap etc. Please be ware that some map source server may not be connected or 
not shown, switch to other map source. 
Map tools-> Prefetch: If there is no internet access at the flight test field, user can pre-
fetch map source at the place which has internet and download the current map content 
and cache it in the local computer. The cache map will be stored at the Map Cache Dir 
directory, current File Name with the directory name gmapcache. This function will pull 
the current showing map area to the zoom level 20 with assigned map source, so it could 
use lots of time and disk storage to cache the map from map provider’s server. 
 
Map tools-> Rotate Map: rotate map image by the heading degree inputted from a 
popped up dialog. 
 
Map tools-> Zoom to: zoom to the place inputted from a popped up dialog. 
 
Address: Input the name of location and then press enter or click button Find, map will 
show the address at the center. This function is only available with internet access. 
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Latitude/Longitude: Input Latitude and Longitude then click button Locate. Map 
control will show the place of input at the center. This function is only available with 
internet access.  
Press Key “Alt” and click point in the map, the Latitude and Longitude will show the 
coordinate from the click points.  
 
Zoom level: Map’s zoom level from 0-20, defines the zoom level of the map, which 
determines the magnification level of the map. Zoom level can be adjusted by rolling of 
mouse middle wheel too. A slide bar on right has the same zoom function. 
Press key “Ctrl” and click at the map and draw a rectangle and map to show the area that 
you want to zoom into. 
 
Map Cache Dir: Set the Map cache directory for map content, directory name 
gmapcache will be created inside this directory for contain all offline map data. 
 
Tips:  Mouse Righ click+ move: User can move the map by this operation, press Esc can 
disable the pop up menu. 
Mouse middle wheel: zoom in or zoom out map 
Select & zoom to area while holding shift and dragging mouse, switching between 
maps keeps selected area in the center 
 

5) Auto Waypoint Design 
This function allows you to draw a polygon (enable Radio button of Draw Polygon Point 
+ right click) and automatically create waypoints over the selected area. 
Add new point: User can add two types of points on the map, waypoint or polygon 
point.this function is to select new insert point’s type on the map 
 
Polygon command: Clear/Save/Load Polygon point to the map 
 
Polygon Options: After draw a polygon area on the map, GEMLink can generate 
waypoints automatically basing on these options. 
Altitude: Default altitude for generated waypoint  
Angle[deg]: waypoint survey line angle to the north 
Distance between lines[m]: Survey line distance 
Spacing inline: waypoint distance inline with the survey line 
Overshoot[m]: how long the survey line is longer than polygon area 
Start from: waypoint index increased from which edge 
 
Display: set waypoint display mode 
Boundary: Show Polygon line 
Internals: generate survey line internal waypoint or just begin and end of survey line 
Marks: Show waypoint marker on the map 
Grid: show survey line 
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Stats: Statistics for the survey area and survey line 
Area: Polygon area 
Distance: Total survey line length 
No of Strips: number of survey strips 
Dist between lines: distance between survey line. 
 
Generate WP by polygon: decide how the new automatically generated waypoints add 
to the list 
Append WP: generated new waypoint appended at the end of existing waypoint 
Clear existed WP: remove all existed waypoints in the list and add the new waypoint at 
the beginning. 
Generate WP: will temporarily show the waypoint in the map, user still can adjust 
“Polygon Options” and change the design. 
Accept: If user satisfies the waypoint design, click this button will insert those new 
waypoints into waypoint list, then the waypoints can be saved to file. 
 

6) General idea of operation for auto waypoint design 
Firstly zoom to the place user want to do geophysics survey area. Prefretch and download 
map with internet  
Secondly set the “add new point” to “Draw Polygon Point”, then make a polygon cover 
all the area user wants to survey. Set “Polygon Options” and click “Generate WP”. click 
“Accept” button, if user satisfies the waypoint design. 
Last click “Save WP File” to save waypoint into file, and click “Save to UTM WP File” 
to save UTM coordinate and transfer them to magnetometer console by the message 
guidance. 
 

4.1.9 Waypoint Tracking Function 
Waypoiny tracking function is to plot and graph data received from serial or survey log 
file replay to check every set waypoing is reached during the survey by set GPS 
information and data information. 
Below is am example picture of Windows 10 Rugged tablet running waypoint tracking 
function with USB wireless zigbee receiver. 
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1) Data Format Setting 
Delimiter: delimiter can be set as coma, space and etc. 
GPS column Setting: Set GPS Latitude Longitude and altitude column for the 
received data. 
If UTM position used, GEMLink can convert UTM coordinate to GPS with user 
provide UTM zone information, note UTM zone and band information is for real 
GPS position, not column index. Y, X and altitude is for data column index. 
 
2) Data Plot Setting 
2 columns data can be plotted in the bottom chart with main and second axis for 
different range data like total field and gradient data. 
 
Main scale and Second sceal:   plot Y axis scale can be set 3 mode as following 
picture. 
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2 Data can be plotted in the chart with same or different axis. 

  
3) Attitude for Navigation 
If data contain heading, pitch and roll information, there will be a redline with 
icon in the map to indication the heading direction. If Head up checked, the map 
will rotate the bearing to keep the heading always head up, this can be used for 
GPS navigation with the survey line and waypoint on the map. 
When user click collapse button(>>) , all setting, data display and plot graph can 
be hidden to give map maximum window size for GPS nagivation 
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4) Log Replay 
Log Replay or real time data from Serial port: waypoint tracking can support 
either to show real time serial data input to GEMLink or to show download log 
replay for survey log.  
When plot real time data from Serial port, the map and plot update rate 
depends on timer setting in menu Setting->Serial Data Update Interval. It can 
be set from 100ms to 10 second. Please be ware that if real time data input rate is 
higher than this, some GPS data could be ignored and relative way point could not 
be checked. 
If Checkbox for Record first reached Waypoints selected, GEMLink will 
automatically record the waypoint information in save log file with waypoint 
index leading with “/” .   
And  user can manual click Insert button to insert mark line number information 
into log file with automatically increment line number setting. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 When Log Replay’s button Replay clicked, a log file open pop up dialog will 
show to user. User can go through the log data with GPS/UTM coordinates and 
data plot for quality checking. The log read interval time can be changed by the 
setting in spin edit box. 
 

 When replay the log, GEMLink will only show the graph and check the waypoint 
status, but not modify log file content, so the Marks function will be disabled as 
following picture and user can not insert waypoint and line mark into the file. 北
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5) Waypoint map operation and file operation 

 
Waypoint map operation is similar with the Waypoint Plan function. User can refer 
above part for the information.  One Tracking Icon combo box can be used to set icon 
for the map navigation. 
Waypoints can be listed in the left grid view box with information got from opened 
waypoint file. Button New, Edit can call Waypoint Plan function out for create or 
modify the waypoint file. Button Load will pop up and open dialog to ask user select 
waypoint file. Clear will remove waypoint list and close current waypoint file. 
Save Progress can save current Passed waypoint information into a new waypoint file 
for work progress record. Show Marker 
And Show Grid is to set the waypoints and survey line display mode on the map. 
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4.1.10 Airborne Menu functions 
1) GPS correction 

 The GPS antenna is mounted with different position from MAG's sensors. Sometimes it 
could be a few meters away. While the bird is flying in different direction, it could give 
errors in different direction. It may cause difficulty to make magnetic map. 
This function is to correct the UTMX and UTMY coordinates by given distance between 
GPS antenna and Sensors position.  
After loading the airborne data file, by clicking ‘Open’ button, select UTMX and UTMY 
column in the dropdown list of combo box, input distance between GPS antenna and 
Sensors position in meter. 
Clicking button ‘Correct’, corrected coordinates will be appended to every line from the 
third data line. 
If correction is successful, a save file dialog will be popped up to let user to save the 
result. 
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2) Survey Path Extract 

Click Menu "Airborne"-->"Survey Path Extract" to enable the function. 
GEMLink provides function to clean the survey path e.g. turn around, out of survey area. 
1. After loading the data log file, and selecting GPS coordinates by dropdown box and 
reference data field. If it is potassium Mag, unlock filter can be used to exclude those 
unlock points by select the unlock indication value. Click “Load to Graph”. A survey 
path with GPS information will be drawn in right top area and a reference data field will 
be shown on the below graph. 
2. Start selection polygon point by clicking button “Pick” in the middle of left menu bar, 
you can start to select the polygon point which can cover you interesting area. After that 
uncheck the clicking button “Pick”, then click “Apply Filter to Graph”, out of polygon 
graph will be excluded as the next picture. 
3. Click “Save to File”, the cut area data will be saved to a new log file which you can set 
a new file name for it. 

 Before cutting 
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 After cutting 
 

3) Grad calculation 
1. Open Datum Adjustment window 

Click Menu "Airborne"-->"Grad Calculation". The following window will be 
shown. 
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2. Load file and Set parameter 

Click Menu "File" --> "Open" to select airborne log file and open it. 
Text box will show the first 50 lines of the file content. 
If the Datum shows value abnormal, it’s probably that the Field Delimiter needs  
to be changed. Please click menu  "File "-->  "Field Delimiter " to change it. 
Select Up,Left,Right Mag Field from the below Combobox and UTMX,UTMY 
parameters.  Set distance between mags. And tick related checkbox for output. 
  

3. Start Grad Calculation 
Click button " Calculation ". The progress bar in the bottom will show the 
progress of the Calculation. Program will calculate the Grad and insert it into the 
new column. 
After processing finished, a save file dialog will be popped out and ask user to 
save the result. 
  
  

4. Check the adjusted log 
Click button "Close". Click GEMLink’s main window Menu "File" --> "Open" . 
Select the adjusted log file to check the adjusted result. 
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4) MAG&GPS tracing graph for Google Earth Mark 

This function is useful when you want to quickly check the result of walking or airborne 
Magnetic field result. It can contains 3 factors including GPS, altitude, 3 MAG value or 
what you can select in the result text format file column. 
 
If want to check the GPS position, altitude, MAGs value’s relationship, the feature of 
‘MAG & GPS tracing graph for Google Earth Mark’ will be the exact tool. 
GEMLink can select GPS coordinates, altitude and 3 MAGs value information to show in 
an analysis window.  
Furthermore, if user installed a Google Earth software (Please download it from Google 
Earth web site),  GPS tracing, altitude and MAGs value can be shown in the Google 
Earth Map with track and the interesting position tag. 
This feature can show the culture factors impacting the MAG result and the magnetic 
abnormal position directly in a real MAP directly without third party complex processing 
software. 
It’s helpful for Walking MAG and airborne system’s result analysis. 
 

  
 
 
 
 
 
 
 

北
京
欧
华
联
科
技
有
限
责
任
公
司



 7

I. Operation Steps 
a) Select Google Earth application path 

Note:  GEMLink does not include Google Earth software, please download it from 
Google Earth web site and download it.  GPS position, altitude, MAGs value’s 
relationship graph can be displayed, but you can not display the generated mark file 
if without Google Earth software. 
 If this is the first time you open this feature in GEMLink, a Google Earth Path setting 
window will pop up to show the application googleearth.exe path which is gotten from 
system register, if this path is right, please click ‘OK’ to save it. If this path is not right, 
please click folder image button in the right of path text box to select proper 
googleearth.exe path.  
 

 
b) Open File with proper delimiter 

Select log file from menu ‘File’  ‘Open’ of GEMLink main window or ‘MAG & GPS 
tracing graph for Google Earth Mark’ sub window with proper delimiter. 
If want to change the delimiter, please select right delimiter by menu ‘File’ ‘Field 
Delimiter’. Application will reload the file and prepare the field for selection in field 
dropdown combo box. 
If loaded file changed from Main window after this feature window opened, please select 
‘File’’Reload’ to reload the file. 

c) Select GPS Coordinates 
Select GPS coordinates by clicking dropdown combo box 
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d) Select Altitude column 

Altitude: Select altitude by clicking dropdown combo box.  
There are two type of altitude, one is GPS altitude, and another is Laser/Radar altitude. 
This type is used for Google Earth Altitude type. The former one is absolute and the next 
one is related to ground. 

 ‘Mark Name’: If log file has title for columns, then ‘Mark Name’ will be automatically 
shown in the dropdown combo box. If it’s not right, then you can select it or fill it 
directly. 
 
‘Star Mark’ and ‘End Nark’: It will show start point and end point mark in the Google 
Earth map for altitude path tracing.  
 
‘Detail Parameters’: If clicking this button, all parameters related to Google Earth Mark 
will be shown in the following window.  北
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 Min: Minimum data value in selected column 
 
Max: Maximum data value in selected column 
 
Map to height: Map the Max and Min value to scale ‘Map to height’ and 0 meter altitude 
in Google Earth. Google Earth provides 3D view of tracing path, altitude and MAG value 
can be drawn as height in Google Earth. Airborne altitude and MAG’s result can be seen 
directly at exact GPS coordinate. MAG’s value range is too much so it need map to some 
small scale for better display. 
 
Style: Poly style and Line Style 
 
Height Mode:  clampToGround 
This mode ignores any altitude value, and places the KML feature on the surface of the 
ground, following the terrain. If you want to see your path rather than the altitude please 
select this option.  relativeToGround 
Measures the altitude from the ground level directly below the coordinates. 

  absolute  
The absolute altitude mode measures altitude relative to sea level, regardless of the actual 
elevation of the terrain beneath the feature  relativeToSeaFloor 
Meaures the altitude from the sea floor directly below the feature, if the feature is placed 
over a major body of water. If not over water, the altitude will be measured from the 
ground level.  clampToSeaFloor 
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As with clampToGround, this mode ignores the altitude value. It places the feature on the 
bottom of any major body of water; if the feature is located away from a body of water, 
the feature will be clamped to the ground level, instead. 
 
Color: Line’s color 
 
Width: Line’s width 
 
Opacity: Line opacity in percentage. 
 
Extend path to ground: Checked, Line in air will be extended to ground, else it’s hang in 
the air. 
 
 

e) Select MAG and IMU value columns 
Totally there are 3 MAGs/IMUs value can be shown in one time. If log has more than 3 
MAG value need to be shown, more than one file for others MAGs/IMUs value should be 
created with the same coordinate column selected. 

 

 Value: Magnetometer’s value or Gradient Value 
IMU: IMU Yaw/Pitch/Roll value  
 
‘Mark Name’: If log file has title for columns, then ‘Mark Name’ will be automatically 
shown in the dropdown combo box. If it’s not right, then you can select it or fill it 
directly. 
 
‘Detail Parameters’: If clicking this button, all parameters related to Google Earth Mark. 
The meaning of ‘Detail Parameters’ can be referred in above content.  
 
Auto Scale: If selected, application will calculate the line height in Google Earth 
automatically, otherwise, it will use ‘Detail Parameters’ Max and Min value as line 
height in Google Earth. 
 

北
京
欧
华
联
科
技
有
限
责
任
公
司



 7

f) Load to Graph 
 After selecting ‘Parameters’, clicking button ‘Load to Graph’, Selected column value will 

be filled into the grid of data as following table: 

  
Selected: Mark the interesting point by GPS information in Google Earth 
Index: Point Index of data line 
Latitude: GPS latitude 
Longitude: GPS Longitude 
Altitude:  altitude information in the log 
MAG1:  the first selected MAG value 
MAG2:  the second selected MAG value 
MAG3:  the third selected MAG value 
Name:  Interesting GPS point mark name 
Whole String: original raw data line stream 
 
The following GPS tracing, altitude and MAG graph will be drawn with the above grid 
data. 
 

g) Generate Google Earth Mark file and loading it to Google Earth 

 Click button ‘Generate Google Earth Mark’ as above, a save file dialog will pop up to let 
user to decide the saving directory and file name for the Google Earth Mark file. Then 
application will call out software Google Earth and load the saved file. The file name will 
be stored in text box of ‘KML file, be careful not to overwrite the existing file. You can 
select another file name by clicking the folder image button on the right. 
 
In Google Earth, the Mark name is listed in left slide bar, by tick and un-tick the mark 
name can show or hide the tracing path. By default, white is the altitude ploy line graph. 
Red, yellow and blue line will be MAG value mapping to height line in the air. Some 
Interesting Point (value abnormal point) is in point mark in the Google Earth.  
 
Please refer to Google Earth manual for detail Google Earth operation like graph rotate, 
zoom in and zoom out etc. 
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4.1.11 Help Menu functions 

 

  
1) HTML Help 

This function will show this help. 
2) Readme.txt 

Readme.txt show the history of version updating information. 
3) World Main Field Magnetics 

Following world main field magnetic map in PDF will be opened for your information. 
US/UK World Magnetic Model -- Epoch 2010.0 Main Field Declination  
US/UK World Magnetic Model -- Epoch 2010.0 Main Field Total Intensity 
US/UK World Magnetic Model -- Epoch 2010.0 Main Field Horizontal Intensity 
US/UK World Magnetic Model -- Epoch 2010.0 Main Field Inclination 
US/UK World Magnetic Model -- Epoch 2010.0 Main Field Down Component 

4) Mouse pointer help 
If enable this menu check button, a help hint will pop up when mouse stay over some of 
the control component.  

5) About 
An about box will be shown with version information. 
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